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Chapter 1

mental ray Essentials

mental ray by mental images is an advanced, Academy Award-winning rendering engine
included with Autodesk’s 3ds Max and 3ds Max Design applications. This industry-standard
renderer is used in a multitude of productions ranging from the latest sci-fi and action movies

to visually rich game cinematics to stunning renderings of vehicles, architecture, and products
yet only imagined. mental ray is integrated in 3D applications from a variety of developers, most
notably by Autodesk, and is the leading rendering application in the world.

In this chapter, I introduce you to a number of important topics for both Autodesk’s 3ds Max/
Design product and the mental ray rendering engine. This chapter ensures that you have a num-
ber of critical skills and all the valuable information that you will need as you move forward.

In this chapter, you will learn to

¢ Setup mental ray

Configure 3ds Max/Design

L 4

Configure gamma settings

*

Configure essential quality settings

*

Adjust Final Gather presets

mental ray Overview

mental ray provides a number of high-end render features:

Bucket rendering mental ray renders scenes in square areas of your image called buckets
or tiles; each processor core in your machine takes a bucket and processes that portion of the
rendering before moving on to process the next available bucket. Brackets appear around
each bucket as it is processing, and when the bucket completes, mental ray jumps to the next
easiest bucket to manage. Figure 1.1 shows completed buckets and four buckets that are in
process on a quad-core machine.
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Distributed bucket rendering Because mental ray subdivides the image into buckets, it
can distribute the rendering of specific buckets to other machines, potentially allowing every
computer on your network to work on individual buckets at the same time with some gener-
ous licensing limitations. Chapter 4, “Rendering,” goes into more detail on this topic. For
large installations, you can add mental ray—distributed rendering licenses by purchasing
stand-alone versions of mental ray from your local reseller.

32-bit frame buffer mental ray works in a 32-bit high dynamic range rendering environment,
using floating-point engineering units for storing render data. The high dynamic range allows
mental ray to represent color and light from the darkest black through the full spectrum of light
to the full intensity and color of the sun and beyond. In addition to producing spectacular ren-
derings, this capability is essential for accurate lighting analysis.

64-bit operating system support 64-bit support means access to as much memory as you can
get into your computer, allowing you to render large and complex scenes. However, mental ray’s
advanced memory management tools also allow 32-bit machines with limited resources to suc-
cessfully render large images.

High dynamic range, energy-accurate materials The mental ray materials Arch & Design and
the ProMaterials series are energy conserving, which means that the energy being reflected or
refracted from or through a surface never exceeds the energy striking the surface. High dynamic
range means a spectacular surface appearance and is essential for both realistic renderings and
accurate lighting analysis.

Photometric lighting and indirect illumination mental ray supports 3ds Max/Design’s
photometric lights and adds a few others to more accurately simulate the sun and sky and to
assist with illuminating interior scenes. As you can see in Figure 1.2, the Indirect Illumination
tools allow you to simulate the natural propagation of light through an environment to pro-
duce highly accurate images that account for all light propagation in an environment.

FIGURE 1.2:
Interior scene with
photometric and
indirect lighting
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Lighting analysis tools mental ray allows you to accurately simulate real-world lighting
and create virtual light meters to measure the illuminence of surfaces to assist you in produc-
ing documentation for Leadership in Energy and Environmental Design (LEED) certification.

Hybrid, adaptive renderer mental ray is a hybrid renderer in that it will use both ray tracing
and fast scanline rendering of elements as needed. This hybrid approach gives you the highest-
quality results with the most efficient use of time and can allow mental ray to render faster
than the 3ds Max/Design’s default scanline renderer for scenes that use ray-traced materials.

mental ray is also adaptive in that it will work harder on areas of your image that need more
refinement, and it can quickly zip through areas that have less detail to resolve. You can define
the quality settings mental ray uses, and you can tune exactly how much an image is refined
as it renders.

In the next section, I cover some of the essentials of configuring 3ds Max/Design to use men-
tal ray and setting mental ray as a default for all new scenes.

Enabling mental ray

In 3ds Max Design 2009 and newer versions of 3ds Max/Design, mental ray is the default render-
ing engine, and the materials in the Material Editor are, by default, mental ray’s Arch & Design
and ProMaterials. When editing legacy scenes, if you are using standard 3ds Max 2009 or are using
earlier versions of 3ds Max/Design, you might need to select the mental ray renderer manually. In
the sample scenes provided on this book’s DVD, mental ray is selected as your rendering engine.

Choosing mental ray for an Existing Scene

To change an existing scene to use mental ray, first press F10 to open the Render Setup dialog
box. Then, as shown in Figure 1.3, select the Common tab, expand the Assign Renderer drop-
down section, and click the ellipsis button (...) to the right of Production to open the Choose
Renderer dialog box. Select mental ray Renderer, and click the OK button.

FIGURE 1.3: !;5, Rencler Setup: Default Scanline Renderer [ o || ® |[22 M ch T

3 oose Renderer T |Ese]
Selectmg mental | Render Elements Raytracer | Advanced Lighting | —
ray Renderer mental ray Renderer A

VOE File i

Assign Renderer

Production:  Defsult Scanline Renderer

Material Editor: Default Scanline Renderer
ActiveShade:  Default Scanline Renderer

Save as Defaults

© [Producion__~] Preset: [High Quaity v

end
(D) ActiveShade View: [Perspechue '] wnclad




4 |CHAPTER1 MENTALRAY ESSENTIALS

Click the Save as Defaults button to make this your new preferred rendering engine for all
new scenes. To quickly switch to mental ray, you can also choose a preset from the bottom of the
Render Setup dialog box that includes mental ray options, as shown in Figure 1.4.

FIGURE 1.4:
mental ray presets
from the Render
Setup dialog box
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Your list of presets might vary from what is shown, depending on your 3ds Max/Design ver-
sion and whether you have any user-defined presets. As with many presets provided with 3ds
Max/Design, they can be a good starting point for many scenes. Creating your own presets for
draft and final quality renderings is a good idea for every project. I provide some sample presets
in the DVD’s Chapter 1 project folder.

Setting mental ray Preferences and Using the Render Message Window

Selecting the Customize > Preferences menu opens 3ds Max/Design’s general Preference
Settings dialog box, which includes the mental ray tab, as shown in Figure 1.5.

FIGURE 1.5: Preference Settings @@]
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Generally I do not modify these settings; however, disabling the options for Show Brackets
and Show Visual Final Gather will speed your renderings by a small percentage as mental ray
will not use time to update the display during rendering. For machines used only for render-
ing, disabling these two options is a good idea as you will most likely not be monitoring the
progress directly. For local rendering, I prefer these to remain enabled. In versions of 3ds Max/
Design prior to 2011, the mental ray preferences included options for controlling the mental
ray Message Window, which streams useful render-time information from mental ray. These
options are now found in the Rendering tab of the Preference Settings dialog box.

New in 3ds Max/Design is the Render Message Window, shown in Figure 1.6, which replaces
the mental ray Message Window in previous versions of 3ds Max/Design. You can open this
window from the Render > Render Message Window option. It will also open automatically in
the event of a render error.

FIGURE 1.6: M Render Message: mental ray Rend bl B ]
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This new general purpose message window now works with other renderers such as the new
Hardware renderer. In addition to preference settings in the Rendering tab of the Preference
Settings dialog box, you can right-click on the Render message window to control message
options, as shown in Figure 1.6.

The only setting I recommend changing at this point is to enable the Show Information option,
which displays useful render-time information to the Renderer Message Window. Reviewing the
Render Message Window at render time allows you to get a feel for what mental ray is doing behind
the scenes; it may alert you to changes you need to make in render or object settings, and it can assist
you in troubleshooting render issues. Messages might include warnings about incompatible features
that are enabled, helpful status messages about connections to other computers, statistics about ren-
der time and memory use, and other details.

Next I discuss a number of key concepts and configuration options that contribute greatly to
the successful production of accurate renderings.

Configuring 3ds Max/Design

Before you can begin to use 3ds Max/Design and mental ray efficiently and in order for your
DVD sample scenes to work properly as you move through the book, you need to configure a
few settings.
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These settings include the following;:

¢ mental ray and 3ds Max/Design defaults
¢ Project folders

¢ System units
*

Gamma options

Exploring mental ray’s Design-Related Defaults
3ds Max/Design allows you to customize the user interface and modify a number of default set-
tings. I wrote this book using 3ds Max Design 2011 with the default light-colored 3ds Max Ul
scheme and certain other default settings related to 3ds Max Design. If you are using standard 3ds
Max or different program defaults, then some examples in the book might not work as expected.
To change your defaults to the DesignVIZ.mentalray presets, from the top menus select
Customize » Custom UI And Defaults Switcher. Select the DesignVIZ.mentalray option, as
shown in Figure 1.7, and click the Set button.
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Within the dialog box, as you switch between various initial settings for tool options (on the
upper-left side), you will see in the Overview window the default settings and behaviors that
differ with each choice. Using options other than DesignVIZ.mentalray may potentially affect
how book examples operate, and are not recommended at this point.

Clicking the Set button causes all new scenes to use these default settings; however, this does
not modify render settings or change objects in existing scenes.

For standard 3ds Max, the UI and Default Switcher option Max is the initial default setting,
rather than DesignVIZ.mentalray as it is with the 3ds Max Design version. With standard 3ds Max,
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you need to manually select the mental ray renderer for any new scenes that you create, as described
earlier in this chapter. The UI Schemes options on the top-right side of the dialog box change your
UT’s color and icon style; this book utilizes the ame-light option. I tend to customize my UI quite a
bit, and if you have previously customized your Ul then be certain to save your current Ul from

Customize » Save Custom UI Scheme before you switch the Ul scheme in this dialog box. This way,
you can restore your last UI configuration settings, if required. Selecting Customize » Customize

User Interface allows you to save and recall individual files for keyboard shortcuts and other UI cat-

egories you may want to recall separately.

Using Project Folders

The purpose of the project folders is to keep assets related to a project within a specific group

of folders, separate from other projects. The example files for the book are divided into separate
folders on the DVD, divided by chapter number. For example, Chapter 1 uses the DVD folder
\ProjectFolders\01_Essentials. For the sample projects to open and render properly, you
need to set 3ds Max/Design’s Project Folder option to point to the correct folder location and use
the project configuration file located there. The project configuration file is a simple text file with
the same name as the project folder and an .mxp extension.

UNIQUE PROJECT FOLDERS ARE USED IN EACH CHAPTER

Each chapter has a unique project folder that holds all of the chapter’s scenes’ bitmaps, rendered
images, and other support files, and you will need to set 3ds Max/Design to use these project
folders as you move from chapter to chapter. For the best results, copy the contents of the DVD’s
\ProjectFolders folder to your local hard drive, a network location, or a USB drive. After copying,
you may need to clear the read-only properties of the files and folder by right-clicking the folder
name, selecting Properties, and deselecting the Read-Only check box. This allows you to update
files and add your own files and renderings to the folders.

Throughout the book I will refer to the \ProjectFoTlders location for sample files and will
assume these are on a hard drive or USB drive and can be updated. You can open the “Browse
for Folder” dialog box to select a project folder location from the far-right icon on the Quick
Access Toolbar, as shown in Figure 1.8, or from the File menu.

If you select an empty folder for your project, Max/Design will create any subfolders nec-
essary to hold project data and create an .mxp file to hold project-specific file paths. This is a
simple text file that you can edit in Notepad, and you can also change it in the dialog boxes that
open when you select Customize > Configure Users Paths.

Because many scenes in this book take advantage of the bitmaps that ship with Max/Design,
you will have to ensure 3ds Max/Design’s map paths are included in your local bitmap paths
within in the MXP file. For Max/Design 2011, this list typically includes the C:\Program Files\
Autodesk\3ds Max Design 2011\maps folder and subfolders, along with new path locations for
the new Autodesk Material Library, covered in Chapter 2. Those maps may include paths such as
C:\Program Files (x86)\Common Files\Autodesk Shared\Materials20ll\assetlibrary_
base.fbm\1\Mats\. Map paths will change based on your installed version and whether you used
the default folder paths for installing 3ds Max/Design.
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FIGURE 1.8:
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This listing is from the MXP project file in the \ProjectFolders\01_Essentials folder for
Chapter 1:

[Directories]

Animations=.\sceneassets\animations
Archives=.\archives

AutoBackup=.\autoback

BitmapProxies=.\proxies

DownTloads=.\downloads

Export=.\export

Expressions=.\express

Images=.\sceneassets\images

Import=.\import

Materials=.\materiallibraries

MaxStart=.\scenes

Photometric=.\sceneassets\photometric
Previews=.\previews
ProjectFolder=C:\Users\Jenni\Documents\3dsMaxDesign
RenderAssets=.\sceneassets\renderassets
RenderOutput=.\renderoutput
RenderPresets=.\renderpresets

Scenes=.\scenes

Sounds=.\sceneassets\sounds

VideoPost=.\vpost

[XReferenceDirs]

Dirl=.\scenes

[BitmapDirs]

Dirl=C:\Program Files\Autodesk\3ds Max Design 2011\Maps
Dir2=C:\Program Files\Autodesk\3ds Max Design 2011\Maps\glare
Dir3=C:\Program Files\Autodesk\3ds Max Design 2011\Maps\adskMt1
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Dir4=C:\Program Files\Autodesk\3ds Max Design 2011\Maps\Noise
Dir5=C:\Program Files\Autodesk\3ds Max Design 2011\Maps\fx
Dir6=.\downloads

Dir7=.\sceneassets\images

The .\ before a file path indicates that the folder location is relative to the project folder. For
instance, if the project folder is D:\ProjectFolders\01_Essentials, then your scenes will be
stored in the D:\ProjectFolders\01_Essentials\scenes folder. This allows you to store files
specific to your project with the project, and 3ds Max/Design will know where to find them.

These are the folders you will use the most:

AutoBackup All automatic backup files related to this project are stored in the \autoback
folder with file name AutoBackupXX.max, where the XX is a circular list of numbers. You can
define the length of this list and other AutoBackup options from the Customize > Preferences
dialog box, and the Files tab.

Images Place any custom bitmaps you will be using for this project in the \sceneassets\
images folder.

RenderAssets Any render-time files generated for indirect illumination, the caching of
scene data, and storage of mental ray Proxy files, are created and stored in the \sceneassets\
renderassets folder.

Scenes All .max and .mac (container) files are created and retrieved from \scenes by default.

[XReferenceDirs] This group of folder contains paths to additional scene files used in your
project. For instance, you might have subfolders in your Scenes folder for various components
of your model or buildings in a development. Defining those subfolders in this section allows
Max to quickly find all related scene files. Typically this will be subfolders of the .\scenes
folder but might be model libraries used for that project contained on other drives or paths.

[BitmapDirs] This section should list all folders that contain material bitmaps files used
in your project. As you can see in the previous listing, the paths used for the book are the
default bitmap installation folders for 3ds Max/Design 2011. I provide separate MXP files for
3ds Max/Design 2009 and 2010 in the project folders on the DVD, and you can drag the cor-
rect version into 3ds Max/Design to set up your project folders; however, you can edit the
MXP file or rename the files if needed.

Keeping this list of map paths short helps 3ds Max/Design find what it needs quickly, with-
out searching through numerous irrelevant folders. If the list is long, you might experience
long delays when you open and render files.

AUTOSAVE AND PROJECT FOLDERS

In addition to keeping all your files together, one of the advantages of using project folders is that
any automatically backed-up files (AutoBackupXX.max files) are saved only to that project’s
.\autoback. folder and will not overwrite backups from any other project. Setting the name used
for your workstation’s AutoBackup files to include your name or initials, such as Jenni_AutoBack,
will separate your files from another user in a networked environment and prevent another user
from overwriting your backup files. You set this filename by selecting Configuration > Preferences
and the Files tab. You can also edit the MXP file to point to a folder on your local computer to further
isolate your backups from others and improve the speed of backing up files for large scenes.
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Setting System Units

The system unit is the underlying generic unit of measurement that 3ds Max/Design uses to store
data. It determines the floating-point accuracy of both geometry and Position/Rotate/Scale trans-
formations, and setting it properly ensures that imported scenes are the correct size and will have
the proper light decay over distance. To set the system units in your scene, select Customize >
Units Setup to open the Units Setup dialog box, as shown in Figure 1.9.

FIGURE 1.9:
Units Setup dialog box
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The Display Unit Scale settings specify how the system units are displayed in 3ds Max/Design’s
dialog boxes and spinners. You can change the display units at any time, and they can be completely
different from the system unit; your display unit choice is simply a unit of measurement that is con-
venient for you, as shown in Figure 1.10.

FIGURE 1.10: © s Standard
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You can change this value at any time, and it does not affect geometry, object translation, or
rendering and lighting whatsoever.

The System Unit Setup button is at the top of the Units Setup dialog box; clicking it opens
the System Unit Setup dialog box, as shown in Figure 1.11. In the United States, the units are, by
default, set to 1 (generic) Unit = 1.0 Inches. For small objects with fine details, a setting of 1 Unit =1
Millimeters may be appropriate to gain additional floating-point accuracy. For large Revit scenes, for
instance, 1 Unit = 1 Feet or 1 Unit = 1 Meters might be appropriate. For planet-sized scenes, a setting
of Miles or Kilometers may be required. The system unit setting is stored with the 3ds Max/Design
file and may generate a warning when files with different system unit settings are opened. Once set,
all new scenes created in your instance of 3ds Max/Design will use these system units.
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FIGURE 1.11: System Unit Setup
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SET SYSTEM UNITS FIRST

You must set the system units before you import or create any geometry, and you should not change
the setting on an existing scene. If you need to change an existing scene, then consider merging
the existing geometry into a scene with the proper system units. To maintain the accuracy of the
imported CAD data, it is best to rescale the geometry in the CAD program that generated the data
file and ensure that all data is as close to the origin as possible. This might mean creating an inter-
mediate DWG file just for importing; however, the benefit in scene accuracy is significant and worth
the additional effort. As you will see in Chapter 9, “mental ray for Architecture,” the AutoCAD file
import dialog box allows you to rescale CAD data on import. It does not, however, allow you to move
data closer to the origin, and this is particularly critical in large civil projects.

If your scene comes in with the wrong units, you can also rescale your scene using the Rescale World
Units tool, found on the Utility tab of the Command panel.

Setting Gamma Options

Gamma correction is an intensity adjustment applied to an image to compensate for nonlinearity
in print and display devices. This nonlinearity can make material bitmaps render too bright in
outdoor scenes or cause your rendered images to appear too dim on your monitor or printer.
With gamma correction, you work in a what-you-see-is-what-you-get (WYSIWYG) environment,
where a bitmap that goes into your rendering pipeline will look the same when it comes out as a
rendered image. Gamma correction is generally required for all 8-bit images saved as JPEG and
PNG, and not for images saved in floating-point formats such as HDR and EXR. For information
on file formats, see Chapter 4.

Gamma is an essential setting, and you must properly configure it on your machine in order
for example scenes in this book to render correctly. 3ds Max Design 2010 and later use a gamma-
corrected workflow by default. However, in standard 3ds Max, in 3ds Max versions prior to 2010,
and when working with legacy scenes, you must manually configure your gamma settings.

Figure 1.12 shows rendered output with gamma of 1.0 on left, 1.8 in center, and 2.2 on the right.
As you can see, adding gamma (to the output of the file, in this case) greatly increases the bright-
ness of your rendered image and makes it appear as if your lighting intensity is set higher. Without
gamma correction, you may have instead reduced the exposure settings, increased lighting inten-
sity, and perhaps added lights to the scene to boost illumination to acceptable levels. Your rendered
images would appear too dark with incorrect output gamma, as shown on the left of Figure 1.12,
and can result in surfaces that appear washed out in your rendering, particularly when using very
bright daylight scene illumination.
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THE GAMMA CURVE

A gamma correction factor is a simple numerical value that describes the shape of a correction curve
applied to the intensity of an image. Gamma correction decreases the intensity of the midtones
in the bitmap images you use in surface materials and increases the intensity of midtones in the
files you save to your computer. A gamma of 1.0 gives no gamma correction (1 = 1 linear results), a
gamma less than 1.0 darkens the midtones of an image, and a gamma greater than 1.0 brightens
the midtones. Image brightness at the extremes, very dark or very light colors, are not affected
significantly by gamma correction. The following graphic shows gamma curves and the increase
or decrease in intensity output values vs. input:

2.2

1w

Output Intensity

45

Input Intensity

FIGURE 1.12:
Image gamma cor-
rected (left to right)
1.0,1.8,and 2.2

You can find all gamma-related settings by selecting Customize » Preferences and going to
the Gamma and LUT tab, as shown in Figure 1.13. These default settings for 3ds Max Design are a
good starting point and might need only minor tweaking, particularly for your personal display.
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FIGURE 1.13: M Preference Settings
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Referring to Figure 1.13, which shows the gamma settings for new scenes in 3ds Max Design
2010/2011, perform the following steps to adjust the gamma options within your installation of
3ds Max Design:

1. Select the Enable Gamma/LUT Correction check box, enabling the option.
2. Select the Gamma radio-button option instead of Autodesk View LUT.

3. Blur your eyes a bit, and adjust the Gamma value spinner until the inner and outer
squares are about the same intensity on your monitor. (This value will differ from moni-
tor to monitor.)

4. Select the Affect Color Selectors and Affect Material Editor check boxes. These critical
settings give you a WYSIWYG color display in the material previews.

5. Set the Input Gamma and Output Gamma values to 2.2 each. These two settings ensure
that images are read from (Input Gamma) and written to (Output Gamma) your bitmap
files correctly and are described in the next section. The normal range for these values is
1.8 to 2.2, with 2.2 being the default.

As you can see in the dialog box in Figure 1.13, my monitor’s Gamma setting is 2.0, and on
my display the two squares look about the same brightness within 3ds Max/Design, yet in this
book the two squares are very different. You will need different display gamma settings for
each computer you use; however, the recommendation is to use 2.2 for all settings, including
your monitor.
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The inner square is 50 percent gray and the outer square contains a tiny black-and-white
checkerboard giving the illusion of being 50 percent gray.; When the intensity of the two squares
is the same, your monitor will have correct gamma correction applied to the display, and your
renderings, bitmaps, and color selections will look brighter. Depending on your version of 3ds
Max/Design, you might have to restart the program for gamma changes to take effect.

ENSURING CONSISTENT GAMMA CORRECTION

With 3ds Max/Design 2010 and newer, gamma settings are now preserved within the *.Max file;
however, in legacy scenes only the gamma enabled on/off state is saved. With 3ds Max/Design and
newer format scenes, you get a warning when you load a file that contains gamma settings different
from your current settings, and you can accept the incoming settings or override the settings with
your current settings, as shown here:

File Load: Gamma & LUT Settings Mismatch

The Gamma & LUT ssttings of the file do not match the
System Gamma & LUT settings.

File's Gamma & LUT Settings:

Gamma & LUT Correction: Enabled
Bitmap Fies Input Gamma: 18
Bitmap Files Quiput Gamma: 1.8

System's Gamma & LUT Settings:

Gamma & LUT Correction: Enabled
Bitmap Files Input Gamma: 2.2
Bitmap Files Output Gamma: 22

Do You Want To:
| Keep the System's Gamma and LUT Settings?
@) Adopt the File's Gamma and LUT Settings?

With these changes to 3ds Max/Design’s file format, your scene’s gamma now works consistently in
Backburner network render jobs without needing to configure every server. For more information, see
Chapter 4, “Rendering.” With 3ds Max/Design 2009 and older, you must ensure that the gamma is set
consistently on each workstation your artists use and also in each machine in your render farm.

If you keep your current settings when prompted by 3ds Max/Design rather than using the gamma
settings in the incoming file, be aware that any bitmap that uses the Use System Default Gamma set-
ting in its bitmap file settings will change the appearance of renderings produced with the alternate
setting. If you need to ensure consistent renderings for a project, then adopt the settings or use the
gamma override in each bitmap (as described in the “When Input Gamma Can Cause Problems” sec-
tion later in this chapter) to ensure consistency no matter what the global gamma preferences.

1f you open a legacy 3ds Max/Design scene, then you may only get a message to follow the gamma
enable or disable states and not the input and output gamma settings.
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UsING INPUT GAMMA SETTINGS

The Input gamma setting, as found in the Customize > Preferences and the Gamma and LUT
tab, de-gamma corrects an image on your drive as it is brought into 3ds Max/Design, shifting
the midtones downward so that the colors render correctly. It prevents bitmaps from appearing
overly bright in your rendering. It compensates for images that were adjusted to look good on
your monitor or when printed and makes them linear. This initial correction may be done auto-
matically by some cameras or can be done in photo-editing software.

The Input Gamma setting is usually in the range of 1.8 to 2.2, and an Input Gamma setting of
1.8 seems to be most pleasing and may more closely match how a bitmap is stored by a camera
or manually adjusted in Adobe Photoshop. An Input Gamma setting of 2.2 is the recommended
default value from Autodesk and mental images, and 2.2 matches the sRGB standard developed
by Microsoft and Hewlett-Packard and endorsed by Pantone, Corel, and others. I use 2.2 for both
input and output gamma settings.

As you can see in Figure 1.14, the Input Gamma setting had a huge effect on the grass, brick,
and wood bitmaps; however, it did not visibly affect the rendered colors on materials that are
using a color swatch, such as the metallic paint on the center structure. The background envi-
ronment and chrome teapot are also unaffected in this case.

FIGURE 1.14:

The left side has
Input Gamma set
to 2.2, and the
right side has Input
Gamma set to 1.0
(disabled).

WHEN INPUT GAMMA CAN CAUSE PROBLEMS
The Input Gamma value can cause issues and undesired results in the following instances:

When a file already contains gamma information TARGA is one of the few file formats
that supports gamma information, and you may change the bitmap’s option to Use Image’s
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Own Gamma in this case. This setting is found in the Select Bitmap Image File dialog box to
specify maps used in your materials, and is shown in Figure 1.15. PNG files also support the
use of gamma; however this is not always used consistently in 3ds Max/Design, and I tend to
override the in-file setting. Some material libraries shipping with 3ds Max/Design may use
the file’s gamma values, and overriding the file’s setting may improve your results.

When using high dynamic range Images Images that are high dynamic range (HDR) 32-bit
floating-point images will not look correct when gamma is corrected, and you will need to
override the Input Gamma value to 1.0 for each HDR bitmap you use. Images that are 16 bits
per channel may not require gamma correction, depending on the bitmap, and you can get a
visual preview in the Select Bitmap dialog box. All low dynamic range (LDR) images, on the
other hand, should be gamma corrected.

When using bump, normal, and displacement maps For most purposes, the Input
Gamma setting should be set to 1.0 when a bitmap is specifically for bump or displacement
use. Otherwise, the bump/displacement will be artificially increased throughout the mid-
range, which may not give you the expected results.

When using the mental ray Map Manager In Chapter 4, I discuss translator memory set-
tings, including the option called Use mental ray Map Manager. This option allows mental
ray to store bitmaps. In some earlier versions of mental ray, this option ignores the bitmap’s
gamma override settings, and mental ray will use only the system gamma settings. In this
case, use the Gamma & Gain map discussed next. This is not an issue with current versions
of mental ray and 3ds Max/Design.

If you are experiencing issues with the default Input Gamma setting for a specific bitmap or
have one of the situations listed where gamma correction would cause problems, you can over-
ride the Input Gamma option in the bitmap parameters using the Material Editor. You can find
the Override option in the Select Bitmap Image File dialog box when you select a bitmap file on
your drive, as shown in Figure 1.15.

FIGURE 1.15: T N IR
File name: ‘Woods&Plastics. FinishCarpentry, Wood, Cocobolo.jpg
The gamma selec-
tion options for the Files of et |l Eomols s —————;|
Select Bitmap Image Gamma
E () Use image's own gamma

File dialog box

() Use system default gamma

@ Override  [1.0 %

Setup...
Info...

View [ sequence [F]Preview

Statistics: 1024x1024, RGE Color 5 Bits/Channel - Single Image
Location: C:\Program Files\A... WoedsPlastics, FinishCarpentry.Woed. Cocobolo. jog

These options give you the opportunity to control or override the Input Gamma setting on
a per-map basis. The Use System Default Gamma choice is typically used; however, I explain
some of the exceptions to using this option in the next section. In 3ds Max/Design 2010 and
newer, the preview thumbnail image will update its midtone brightness based on changes to
the gamma setting.
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UsING THE GAMMA AND GAIN MAP

The Gamma & Gain (mi) map gives you image input gamma control over individual bitmaps
to assist in overcoming limitations you might experience with the global Input Gamma setting,.
In 3ds Max/Design 2010 and older, this map was called the Utility Gamma and Gain map. The
“(mi)” after a map or material name means that it is produced by mental images and is for use
with mental ray. If you are instancing bitmaps in your scene (creating clones that are always
identical), utilizing a noninstanced Gamma and Gain map where needed allows you to control
specific bitmaps without affecting the other instances because only the bitmap, not the Gamma
and gain map, will be instanced. These instructions are for the Compact Material Editor, for-
merly just the Material Editor; however with the addition of the ne Schematic material Editor
(SME) the name has been changed. The new SME is covered in Chapter 2.

Perform the following steps to add the Gamma and Gain map wrapper to a bitmap:

1. From the settings of your bitmap, click the Bitmap button to open the Material/Map
Browser, as shown in Figure 1.16 for the classic compact editor and as shown in Figure
1.17 for the new Schematic Material Editor (SME) version of the Material/Map Browser.

FIGURE 1.16: [y p— TR B, Mtoterial Edor - Arch & Design mil13 == & |
Adding the Gamma —— Create New Haterizl / Man (b Neme] = = -
& Gain wrapper to e Haas E
amap in the classic ] amblentiehecthe pezusian =
Material Editor Mo g’
‘_‘3'

A=

— w2

[ colorcomaction
Color Cverde/Rary Type Switcher

Afactance | Tensetiance
A 2% Mk 3% Aug: D% Man 0% DiFise: 0%

9% 1% %% & @ 0 e e

D Cokor 7 varnished mood (4] .-l itnzp
o &)
=

Conmpaste

ersion Color fn Float
[ corversion Aoa Ta Colae

188 et

: H
[ ] Ball || e[l [T O E s
W =nrcnmest FrobafGray Eal | &aw ew ew L e
:_ o = || Br: [T Bur et [TT = Aotat

Enaircnressl Beadkureand Sead cher I —
0 masace It —— =
— aleff | 2l
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FIGURE 1.18:
Gamma & Gain set-
tings to de-gamma
animage
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2. Make sure New is selected in the radio buttons on the left of the dialog box, and then
scroll down and select the Gamma & Gain (mi) map.

3. Click OK.

4. You are asked whether you want to discard the old map or keep it as a submap; you
will want to keep the map for this example. Your original map is now “wrapped” by the
Gamma & Gain map, and the bitmap is processed by the Gamma & Gain map before
being sent to the renderer.

Figure 1.18 shows the settings for the Gamma and Gain map. The Reverse Gamma Correction
check box is selected by default and applies an inverse gamma correction to the bitmap, which
in this case would be a gamma of approximately 0.454545 (1 + 2.2). Be careful not to use gamma
correction in the bitmap setting and in the Gamma and Gain map, because you will double-
correct the image and end up with a very dark bitmap.

« v ‘e

| Refiectance Transmittance |
Avg: 0% Max: 0% Avg: 0% Max: 0% Diffuse: 0%

B2 % IXI% R &0 S Mes
Diffisse Color j varrished wood (diffuse)  ~ amma & Gain (mi)
. Utility Gamma & Gain (i) Parameters ES

T TR ot e A o s - M
(006000600060 05808 003G 005 |22_ s
Gain (multiplier) . ... I
Reverse Gamma Correction (De-Gamma) . .[J]
Maps &[;
Mt .......... 5.Fiooring. Wood Plank.Beech.jpg) ) [~

Unfortunately, there is little you can do to fix a rendered image with an incorrect Input Gamma
setting, other than doing some Photoshop work on selected objects. This would need to be done on
a per-material basis, provided you can mask those areas in Photoshop, and you would not gamma-
correct a complete image because that would also shift rendered colors that would not have been
normally changed in the gamma process.

Your best course of action, if you have the time, is to set the Input Gamma value correctly and
rerender your image. Otherwise, use Photoshop to adjust regions of your image.

OuTtpPuT GAMMA SETTINGS

The Output Gamma setting shifts the midrange colors of a saved file upward to a range that will
display well on other display devices. Output Gamma is different and independent of your dis-
play gamma and affects only the raw rendered image as it is transferred to a file.
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@ Real World Scenario

PRACTICAL OUTPUT GAMMA

1f your rendering looks fine within 3ds Max/Design but your client says the image looks too dark,
consider turning up the Output Gamma setting in your preference settings or in the Output Gamma
settings of yourimage’s settings. A value of 2.2 is the default Output Gamma setting with 3ds Max/
Design; however, you might want to set the Output Gamma value to be the same as your monitor’s
gamma value. Ultimately, you are compensating for your client’s monitor or printer, and the default
of 2.2 is usually sufficient.

Many users find a setting of 1.8 for Output Gamma looks best to them, but that might depend on
the relative brightness of your scenes and your exposure settings, too. If you find yourself always
adjusting the brightness of your renderings in photo-editing software, then you might want to
consider using a different Output Gamma setting. An output value of 1.8 is fine for something that
may be viewed on computer displays, but a setting of 2.2, the default, is common for video and
matches the HP/Microsoft sRGB standard for monitors.

WHEN OuTPUT GAMMA CAN CAUSE ISSUES
The Output Gamma value can cause issues and undesired results in the following instances:

When saving to high dynamic range images This includes formats such as HDR, EXR, and
32-bit TIFF. Gamma is necessary for low dynamic range images and should not be used for
these file formats.

When saving alpha channel information The gamma correction would change the trans-
parency levels in the midrange of the alpha channel.

When using the logarithmic exposure control The logarithmic exposure control adds a 2.2
gamma correction to your rendered image. See Chapter 3 for specifics on exposure control.

When using Backburner to render to strips Rendering to strips allows multiple machines
to render a large image, each taking a horizontal strip of the image. Two Backburner jobs are
created: one for the strips and one for stitching the strips together into a final image. Both
jobs add output gamma correction, and the image is corrected twice. For more information
on network rendering, see Chapter 4.

In these instances, you should use an Output Gamma setting of 1.0 in your preferences, man-
ually adjust the gamma in another application such as Photoshop, or control the gamma setting
in the Render Output File dialog box for the saved image, as shown in Figure 1.19.

.
FIGURE 1.19: File name: Lightiab. exr
Gamma override
) Save a5 typei | DpenEXA Image Fie [%ex."fu]
options
. Use image's own gamma
Setup... Use system default gamma
@ Override  [1.0 Lz
Info...
View el |

Statistics: 1280x720, RGBA Color 32 Bits/Channel - Single Image
Location: P:\Mastering_mr<DV\ProjectFolders\03_Light_Shadow_Ex...\LightLab.exr
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Setting the Override value in the Render Output File dialog box is the most direct method of
ensuring the output gamma is the value you desire, especially when working between multiple
machines and in workgroups. As you will see in Chapter 4, using the Batch Render utility can
also help ensure that output settings are always preserved.

If you need to correct the output gamma, open your image in Photoshop or a similar pro-
gram, select Image > Adjustments > Exposure, and set the Gamma Correction value to some-
where between 1.8 and 2.2, as shown in Figure 1.20.

FIGURE 1.20: Exposure
Photoshop’s Expo- B 000
sure dialog box @ e
Offset: 0.0000
: 0
Gamma Comection: 1.4
: i} ;
v
[] Praview

If your image was gamma-corrected twice, as with a Backburner Render to Strips job (see
Chapter 4), then in the Gamma Correction field enter 1 + gamma value, which for a 2.2 gamma is
0.454545. This shifts the image back into the proper range. Do not use any brightness or contrast
settings to adjust the image until after gamma correction. After adjusting the gamma, it is also
best not to use the Exposure or Offset options of this dialog box to adjust any 8- or 16-bit per
channel images, because you can obtain much more direct and superior results by using the
Curves tool (Image » Adjustments » Curves) of Photoshop.

In Autodesk Combustion, you need to add a Gamma/Pedestal/Gain node from the schematic
view’s right-click menu Add Operator » Color Correction » Gamma/Pedestal/Gain, placing it
just after your file node and then adjust the gamma setting as shown in Figure 1.21. It works in
an identical fashion to the Photoshop Exposure controls.

FIGURE 1.21: il B [Tk | GammaPedsstalGain Cantrts
Gamma correction
adjustments in
Combustion

In Autodesk’s new 3ds Max Composite application — based on Autodesk Toxik — you can
gamma-correct your images by adding the CC Basics node after your footage, as shown in
Figure 1.22.

FIGURE 1.22:

3ds Max Composite’s
CC Basics node with
its master gamma
correction option set

t00.45454




QUICK-START RENDER SETTINGS ‘

In the next section, I cover some of the critical mental ray settings and features that you need
to get started using mental ray.

Quick-Start Render Settings

Although I delve into the mental ray render settings in detail in Chapter 4, it is important to take
some time at this point to cover a number of settings that come into play in the examples in the
next two chapters.

Introducing the Sampling Quality (Antialiasing) Settings

The Sampling Quality (Antialiasing) settings are a group of mental ray settings that include
Sample per Pixel, Spatial Contrast, and Filter, and are the first few mental ray settings that are
critical for you to understand. The settings are found in the Render Setup dialog box (press F10),
and the Renderer tab. As the group name implies, these settings greatly impact the quality of
your rendered image and as you will find, also impact the speed of your rendering.

DEFINING ANTIALIASING

Aliasing is missing or incorrect information in a rendered image due to an under-sampling of
bitmaps and rendered elements. Simply put, it is the uneven edges in rendered images.

In Figure 1.23, you can see an under-sampled draft-quality rendering compared to a moder-
ately antialiased and then highly sampled rendering.

FIGURE 1.23:
Low, medium, and
high antialiasing
settings in 3ds
Max/Design

Under-sampling a rendering causes a distortion of the bitmap as the frequency of the check-
erboard pattern increases into the distance. You will see jagged edges at pattern transitions,
which is a high-frequency color transition, and aliasing shows up as very blocky areas rather
than smoothed edges. Figure 1.24 shows four-times magnified images of the low and highly
sampled images.

FIGURE 1.24:
Zoomed-in images
of low and high
antialiasing
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When images are properly antialiased, you gain image detail and reduce or eliminate unde-
sired patterns in images, and you can reduce scintillation and image “crawling” in animations.

SAMPLES PER PIXEL SETTING

The Minimum and Maximum values for the Samples Per Pixel setting control how much effort
mental ray is going to invest in rendering a pixel (or group of pixels) based on the composition
of your scene, and they are the primary antialiasing controls.

On the Renderer tab of the Render Setup dialog box, you'll see the Sampling Quality drop-
down list and the settings for Samples Per Pixel, as shown in Figure 1.25.

FIGURE 1.25:

g; Render Setup: mental ray Renderer e =]
The .Sam.ples Per Pixel indrectTuminaton | Processng | Render Bements |
settings in the Render : e
Setup dialog box vl .
— cobolTuwngPaametss ¥
[ Sampling Quality ”
Samples per Fixel Filter

FIGURE 1.26:

Image Predision {Antialiasing): Soft Shadows Predsion: Final Gather Precision: Reuse
The Image Preci- High: Min 1, Max 16 [1 - Defmuit Low B Cleeomery
sion setting in the g 0 . 0 0 [Final Gather (3§
Rendered Frame Glossy Reflections Predision: Glossy Refractions Predision: Trace Bounces Limits
Chioata® a Product -
Window 10X - Defait [L.OX - Defautt O T - —

Minimum; Type: Triangle -
Maximum: |15 - Width: [z 2

Height: |2,r_| 5
Spatial Contrast
rif605 #e:[60s e 00s lfaftos & [l
Options
[¥]Lock Samples Bucket Width: [38 |2
[] 3itter Bucket Order! [Hibert (best)

Frame Buffer Type: | Floating-Point (32 bits per cha =

The Minimum setting allow mental ray to work quickly through easy areas such as envi-
ronment maps and evenly colored areas and is the starting point for antialiasing your image.
mental ray steps up through the Samples Per Pixel settings as more antialiasing is needed for an
individual sample, and the Maximum setting is the upper limit for sampling.

The Image Precision setting in the Rendered Frame Window, as shown in Figure 1.26, gives
you a convenient slider for choosing Draft through High preset settings for the Samples Per
Pixel values. You can open the Rendered Frame Window from the Rendering > Rendered Frame
Window option, or from the toolbar.

Max. Refractions: |6 s
3 - Render
8] U FG Bounces: 2 .

The Samples Per Pixel settings of Minimum and Maximum should be two to three levels
apart from one another for efficient rendering. They should not be farther apart than four steps,
and they should not be equal. A Samples Per Pixel greater than Maximum = 64 is rarely needed;
in addition, do not use settings higher than 16 or 64 in your scenes unless you understand the
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render-time impact and have determined you need more detail. With a higher Samples Per Pixel
value, you need to adjust the Spatial Contrast settings (described next) downward so mental ray
will utilize the higher Samples Per Pixel settings.

SPATIAL CONTRAST

Spatial Contrast is a color that mental ray uses to compare adjacent samples to determine whether
additional sampling is necessary. mental ray compares the current sample (wWhether groups of
pixels or subpixels) with its neighbor samples, and if the difference (contrast) between the two
is greater than the color of the Spatial Contrast setting, then mental ray will switch to a higher
Samples Per Pixel setting and subdivide the pixels for greater detail.

In the example quality settings in Figure 1.27, each pixel would be sampled whole
(Minimum = 1), and if the pixel next to it (another sample) had a color difference greater than
0.051, then it would subdivide that current sample into four new %-pixel samples.

FIGURE 1.27: ' Sampling Qual 2|
. Samples per Pixel Filter
Spatial Contrast Moimam: 4 = inall
settings of 0.051 Masimum: |4 v width:  [40 &
Height:  [40 i
Spatial Contrast
R:[005T 3 0051 f2{e: 0051 [+ a:[005 &

A Spatial Contrast setting of 0.10 or greater will speed up draft renderings considerably,
because mental ray will choose the Samples Per Pixel settings closer to Minimum more often as
it renders your image. A setting of 0.02 or less produces higher-quality results and forces mental
ray to subdivide samples toward the Maximum setting more often.

LOWER THE SPATIAL CONTRAST BEFORE YOU USE HIGH SAMPLE RATES

Often you can get a better and quicker render by reducing the Spatial Contrast setting rather than
going to extremes for the Maximum value of the Samples Per Pixel setting. You can use a Spatial
Contrast setting of 0.02 for higher-quality renderings, and you can even go a bit smaller to force more
use of the Maximum value of the Samples Per Pixel setting. You should always consider lowering
the Spatial Contrast value when you adjust Samples Per Pixel to higher sample rates; otherwise,
mental ray will not utilize the higher settings.

A Spatial Contrast setting less than 0.015 is rarely needed, so leave it around 0.025 for most
final renderings, 0.09 for fast draft renders, and less than 0.025 only if needed. Lower Spatial
Contrast settings force the increased use of your Samples Per Pixel maximum, potentially caus-
ing the unnecessary use of high Samples Per Pixel levels, which may be inefficient for your par-
ticular rendering. I examine ways of visualizing and optimizing your Sampling Quality settings
in Chapter 4.

Because human vision is less sensitive to green and blue colors, a Spatial Contrast setting
of RGB 0.02, 0.04, and 0.06 can speed your renderings without a significant impact on the
finished result.
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FILTERS

Filters, as shown in Figure 1.28, take your raw rendered samples and turn them into final image
pixels, blending between adjacent samples and pixels based on one of several filter algorithms.
Filters are covered in more detail in Chapter 4.

Brief descriptions of each filter follow:

Box filter A simple summing filter. This is the quickest sampling method with the roughest
results. It is the default setting and should be changed for all production work.

Gauss filter A blurring filter based on a bell curve. This is great for animations where you
might experience flickering or scintillation.

Triangle filter A filter that’s fast and great for drafts. It filters samples in a pyramid pattern
centered around the pixel being evaluated.

Mitchell filter A sharpening filter using a steep bell curve. This is the best mode for most
still images.

Lanczos filter A bell curve-sharpening filter where samples farthest away from the pixel
have less effect. This is great for final renders and the slowest method.

Filters can add significant time to your rendering. For any final-quality renderings, avoid the
default Box filter and use a Mitchell or Lanczos filter. If you are rendering an animation, con-
sider the Gauss filter with a 2.0 dimension. For draft-quality renders, use the Box filter or, for a
little better quality, the Triangle filter.

Next, I cover some quick-start settings for Final Gather, a tool and technique that produces
indirect illumination in your scene.

Introducing Final Gather

Final Gather (FG) is a method of collecting indirect or bounced illumination from your scene. It
improves the realism and brightness of your rendered images and is a visible prepass process
when rendering an image. In 3ds Max/Design 2010 and later, Final Gather is enabled by default for
new scenes, and understanding a few basics and ground rules will help you get started using this
feature. Final Gather is covered in detail in Chapter 5, “Indirect [llumination and Final Gather,” and
its use with other indirect illumination methods is covered in Chapter 6, “Global Illumination
and Caustics.”

The settings for Final Gather are in the Render Settings dialog box’s Indirect Illumination tab
and also in the Rendered Frame window, as shown in Figure 1.29. Final Gather is easy to use, and
you simply need to enable it (you can do this with the Image Precision slider in the Rendered
Frame window), choose the Draft, Low, or Medium setting, and add one or two diffuse bounces.
It is rare that Final Gather settings greater than Medium are needed for a scene.
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Max. Refractions:  [6& -
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FG is ideal for almost any rendering and is often combined with global illumination for

highest-quality indoor renderings and is used alone for outdoor scenes.

@ Real World Scenario

RENDER, TWEAK, REPEAT: PLAYING WITH MENTAL RAY

One of the most time-consuming aspects of learning and using mental ray is creating test-renderings
of a scene. You render, examine, tweak settings, render, compare, tweak, render, and repeat. It
takes a lot of time and a lot of experimentation, and the trick is not having this experimentation
eat up all of your time when you should be making progress on a project. Most people do not have
the time or the inclination to spend countless hours rendering scenes to figure this all out — and
that is why you have this book. Much of the focus of the book is to help reduce your test-renders
and experimentation time while achieving quality results. I discuss a lot of features and settings
throughout the book that all combine in various ways to give you the speed and quality you need,
and I stress what is important to understand as you go along.

1 have seen many people, my students and professionals alike, become frustrated with this won-
derful renderer because of long render times or low-quality results, when simply understanding
and adjusting a few settings could make their experience faster, make it more enjoyable, and make
their final images a much higher quality. Sometimes the issue is their expectations of how long it
should take to render an image. I get mildly amused when people are shocked at 10- to 15-minute
renders when I routinely dealt with 24-hour renders in the early days. These days, | may even have
my render farm burning away for several hours on final renders for a large project.

When people ask me what the best way is to learn mental ray, my first response, albeit somewhat
tongue in cheek, is for them to get another computer they can use for the render-tweak-repeat pro-
cess. Getting additional hardware is not always practical for my readers, of course, so throughout
the book I provide rendered image samples to highlight differences and show render times so you
can benchmark the results. 1 have a farm of 64-bit quad-core computers at my disposal, which
makes it much easier to play with and explore mental ray. Providing sample renders and detailing
render times in the book should both help reduce the amount of testing you must do to understand
the concepts and help you make decisions about the settings for your own scenes without having
to invest time in extensive experimenting.

That said, the best way to learn is to do, and if you are like me, you will most likely open up one of
your own scenes and begin playing with whatever features are discussed. Doing hands-on experi-
mentation — playing — with scenes is animportant part of the learning process. 1 do a lot of playing,

25
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and I certainly encourage you to do the same. However, remember that just because a setting goes
to Very High doesn’t mean that this setting is practical to use, that it will generate the results you
need, or that it will render in the time frame you require.

Start low with the draft settings discussed in the book, and then work your way up. In addition to
utilizing draft-quality settings, making liberal use of 3ds Max/Design’s Area To Render options
to render only what you need to test will save you significant time during the iterative process of
learning and testing. Utilize additional hardware if you can, and read Chapter 4 to learn additional
render strategies for optimizing your settings, using additional machines, and using tools to queue
jobs to render when your machines are idle.

You have already been briefly exposed to the mental ray settings you will work with the most:
the quality settings (including antialiasing) and Final Gather. You have also learned some critical
3ds Max/Design settings such as Gamma and Scene Scale. 1 recently provided training at a large
architectural firm in Chicago with offices worldwide and worked with some of the designers who
produce images for clients that are constructing some of the tallest and most expensive buildings
ever conceived. Simply covering the topics in this chapter got a good portion of their rendering
issues ironed out and gave them a conceptual platform to start building more knowledge about
mental ray — a good starting point from which to move forward.

Armed with these first few settings in Chapter 1, you should now create at least two render
presets for quickly retrieving these settings within your scenes: one preset for fast draft-quality
renders and another for final high-quality renders. These presets will give you a good starting
point for working with both the sample files for the book and your own projects. Presets allow
you to quickly switch between draft and final settings, minimizing test-render time and helping
reduce mistakes in final settings.

Perform the following steps to create draft-quality render settings:

1. From the Quick Access Toolbar, set 3ds Max/Design to use the project folder for
Chapter 1, \ProjectFolders\01_Essentials.

2. Open the QualitySettings2010.max file from the project folder’s \scene folder. (There
is an alternate 3ds Max 2009-compatible file in the folder, too.)

3. This file purposely has gamma disabled, and if you are using 3ds Max/Design and have
gamma enabled, you should get a warning dialog box for the gamma setting. Accept the
incoming settings.

GAMMA IN SAMPLE SCENES

Unless otherwise indicated, you want to ensure that gamma is enabled for all scenes used for
this book and that you are using a value of 2.2 for the Input Gamma and Output Gamma settings.
Opening the example scenes in the book will bring in the correct settings as needed, provided you
accept the incoming file’s gamma. If necessary, select the Rendering » Gamma And LUT Setup
menu to reconfigure the values.
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Open the Render Setup dialog box (press F10), and on the Common tab, open the Assign
Renderer drop-down menu. Click the Choose Renderer button to the right of Production
to set mental ray as the rendering engine.

Set your output size to 800X600.

On the Renderer tab, set the Samples Per Pixel settings: Minimum=1/16 and
Maximum=1.

Set the Spatial Contrast RGBA settings by clicking the color swatch and adjusting the
Value number to 0.09.

Set Filter Type to Triangle.

On the Indirect Illumination tab, ensure that Final Gather is selected, choose the Draft
preset, and set Diffuse Bounces to 1.

Open the Rendered Frame window, and optionally set Glossy Reflections Precision, Soft
Shadow Precision, and Glossy Refraction Precisions to a Low or Disabled state (move
slider to the far left to disable the feature).

In the Rendered Frame window, choose the Save Preset option in the Render Preset drop-
down list. It should default to the \renderpresets folder of your current project.

Click Save in the Render Preset Save dialog box; a list dialog box opens. Hold down
the Ctrl key and highlight the Common, mental ray Renderer, Processing, and Indirect
Ilumination options. Then click Save.

Render the camera view, and note the render time.

These settings are a good starting place for a new scene and do not take up much render-
ing time as you test and tweak. Turn down the Minimum and Maximum values for Samples
Per Pixel if you still need better performance from more complex scenes, albeit with a grainier
image. Other strategies for faster draft render times are covered in Chapter 4.

On the DVD, in the \ProjectFolders\01_Essentials\renderpresets folder, you'll find a
mental ray draft-quality preset you can use, called DraftQuality.rps.

Perform the following steps to create a high-quality render preset:

1.

In the Render Setup dialog box, on the Common tab, set Output Resolution to HDTV
1920x1080.

On the Renderer tab, set the Samples Per Pixel settings as such: Minimum = 1 and
Maximum = 16. If more detail is needed, settings of Minimum = 4 and Maximum = 64 or
Minimum = 1 and Maximum = 64 work well, too. (Hint: Use the Rendered Frame win-
dow’s Image Precision slider.)

Set the Spatial Contrast RGBA settings to between 0.025 and 0.015 each. Lower numbers
mean higher image refinement but potentially longer render times.

If you are producing an animation, set Filter to Gauss, and set Width and Height to 2
each. Use the Mitchell filter for sharp still-image renderings.

On the Indirect Illumination tab, set the Final Gather preset to Low or Medium, and set
Diffuse Bounces to 2.
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6. In the Rendered Frame window, set the Glossy Reflections Precision, Soft Shadow
Precision, and Glossy Refraction Precision settings to a Medium 1.0x or higher state.

7. Save your preset to a new file.

Your available time to render and the unique needs of your image are always the biggest
determining factors in what settings to use. As you gain more experience with these settings,
you will know where to start for most scenes. As you can see in Figure 1.30, there is considerable
difference between the results of the draft and high-quality settings.

FIGURE 1.30:

A RAM player split-
screen comparison
of the draft (left) and
high (right) rendering
results at 800X600

On a single 2.44GHz quad-core computer, this 3ds Max/Design 2011 scene with draft
settings took 1 minute 52 seconds, whereas the same scene with the high settings took 42
minutes 25 seconds. This is a huge increase in rendering time for a seemingly uncomplicated
scene, certainly; however, a lot of factors go into why the draft render was so fast, including
the ability in 3ds Max/Design 2010 and newer to easily override and disable reflection, refrac-
tion, and shadow settings. I present a number of factors that go into render time throughout
the remainder of the book.

The rendered images are in the \renderedoutput folder of the Chapter 1 project folder, and
preconfigured draft and high-quality sample scenes are in the project’s \scenes folder.

The Bottom Line

Set up mental ray There are relatively few global mental ray preferences for mental ray, and
they primarily affect the visibility of render buckets and the functionality of the mental ray
Messages window.

Master It Change the mental ray preferences to allow logging of render-time
information.

Master It Enable mental ray for your current scene.
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Configure 3ds Max/Design 3ds Max/Design 2011 is preconfigured with mental ray as the
preferred rendering engine for all new scenes and has other internal presets to assist artists
and designers specifically manage imported CAD data, among other things. Proper configu-
ration ensures that sample files and imported data operates correctly.

Master It Configure 3ds Max/Design to use the DesignVIZ.mentalray preset template
and ame-light user interface.

Master It Set your project folder to the Chapter 1 location.
Master It Configure your system units to use millimeters for all scenes.

Configure gamma settings Gamma is an intensity adjustment made to an image to compen-
sate for nonlinearity in display and print devices and is necessary for low dynamic range images.

Master It Enable gamma correction, and adjust its preferences.

Configure essential quality settings mental ray adaptively samples your scene as it ren-
ders, subdividing portions of the image into smaller and smaller parts, to produce the final
image. Controlling the sampling has a great impact not only on the quality of your rendered
image but on the amount of time it will take to render.

Master It Choose settings for a fast draft-quality rendering and save as a render preset.

Adjust Final Gather presets Final Gather is one of several methods of calculating indirect, or
bounced, illumination in your rendering. It is enabled by default in 3ds Max Design as a draft
preset and must be enabled manually in legacy scenes and other flavors of 3ds Max/Design.

Master It Enable Final Gather, and choose medium-quality settings.






